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System Requirements

Version 4.0

The following requirements are for Perspective™ operating in a traditional LAN/WAN environment with the Web server
component running on a separate Microsoft® IS box. These configurations are for planning purposes only—please work
with your PPM account manager for a specific assessment of your needs. These requirements apply to Perspective™
V.4.0 and Perspective Focal Point™ V.1.2.

Minimum Recommended

Client Machine

Processor Speed 1.5 GHz 3 GHz+

Memory 1GB 2 GB+

Operating System Windows® Vista SP 3, Windows® 7 SP 1, Windows® 8
.NET Framework Version 4.0

Web Browser — Launch
Perspective

Web Browser — Web
Portal

Internet Explorer® 7.0, Internet Explorer® 8.0, Internet Explorer® 9.0, Internet Explorer® 10.0

Internet Explorer® 10.0, Chrome v29+, Safari iOS5.1+, Android Browser 4.2+

Adobe® Reader®9.4.0+
Microsoft Office® 2007 Microsoft Office® 2010*
Sun Java™ Runtime Environment 7 U15+2
Qlikview™ Analyzer Plug-in for Internet Explorer®

Third Party Application

Mobile iOS App i0S 5,i0S 6,i0S 7
Available Disk Space® | 1GB 1GB
Processor Speed 2 GHz 2 GHz multicore or better
Memory 4GB 8 GB+

Windows Server® 2008 SP 2 64 bit with 1S,
Operating System Windows Server® 2008 R2 SP 1 64 bit with IS,

Windows Server® 2012 with 1S

.NET Framework Version 4.5 with http and non-http activation
C++ Runtime Libraries C++ 2010 SP1 Runtime Libraries (x64) 10.40219
QlikView™ Server® 64 bit Version 11.20 SR1
SQL Server® Machine®
Available Disk Space 2 GB 20 GB+, SCSI Hard Drive
Processor Speed 3 GHz 64 bit Server Dual Core or Multiple Processors
Memory 2GB 4 GB+
Database Server™ SQL Server® 2008 Standard SP 1 or R2, SQL Server® 2012 Standard or Enterprise
Reporting Services SQL Server® 2008 Reporting Services, SQL Server® 2012 Reporting Services

Deployment Note: Perspective client is deployed as a ClickOnce application, launched from Internet Explorer®; it has a
zero client footprint and does not require administrative rights to launch. Refer to last page for more details on ClickOnce.
Network Note: If single sign-on authentication or add from Active Directory® is used, the Active Directory® Services must
be enabled on the Perspective Web Server.

DTC Note: Perspective Integration Services requires the Microsoft® Distributed Transaction Coordinator (DTC) service to
be installed and enabled on the Internet Information Services (1IS) for Windows® Web Server and the Microsoft® SQL
Server® for Perspective.

This requirement only applies if using Outlook® email integration.

This requirement only applies if using the Visual Analysis component.

This requirement only applies to Perspective Focal Point.

These requirements are for systems with 5 to 25 users. For Perspective systems with more than 25 users, please contact your PPM
Account Manager for a specific assessment of your needs.

Depending on the size of your Perspective database, more disk space may be required for Perspective Focal Point and the Workflow
component.

6.  This requirement only applies to Perspective Focal Point. A limited QIikVieww Server license is included with Focal Point.

rwNPE
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Standard Install

SQL Database Server

1.

Ensure Microsoft SQL Server 2008 Standard SP 1 or better has been installed.
Install the Perspective database:

a. Launch Microsoft SQL Server Management Studio.

b. Rightclick DBS and select Restore Database.

c. Under From Device, click the Browse (...) button and browse to the appropriate
database: default, sample, or system.

Note: Standard backups can usually be found in Perspective Install > Database Setup
> New. If you're unsure which database to use, contact your Perspective Administrator.

d. Click OK.
e. Check the Restore option.

f. Enter a database name in To Database, then click OK. The database should now
appear in the database list.

Create a new SQL user that will be used by Perspective to connect to the SQL Server:

a. Launch Microsoft SQL Server Management Studio. In the menu on your left, expand the
Security node, right-click Logins, and select New Login.

“: Microsoft SQL Server Management Studio Express

File Edit “ew Tools ‘Window Community  Help
: = -
Dhevoey | B i@ BPERES
Q ey ~ & x Summary - X
BYeTE @ Ee T EE
=) [ (b BETAVSGLEXPRESS (SQL Ser 4 |
1 Databases i .
= [ Security Lj Loglns
SR ooins 3 - ETAISQLEXPRESS)| SecurityiLogins 10 Item(s)
L& Ac[ Mew Login. .. I |
x5 B Filter SN
fr;| EE | Created I -
ey B Reports Y Trackclisnt 11/12{2010
%315'- Refresh 2\50LServer200SMSFTEL. .. 1147/2007
o In e SO Server2005MSS QLU 11472007
ch NT ALITHORITY| O8] BUILTIMyAdministrators 117 /2007
A NT AUTHORITY),
2 e o BUILTIN sers 11j7/2007
E Za A INTERMAL\ron. fradette 3/5/2009
. o |
£ Server Reles a NT AUTHORITV:NETWORK SE... 11j?i200?
Credentials A NT AUTHORITY|SYSTEM 117/2007
— . l:-l e i i 14 fzatenng LI
[« | r
Ready v
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b. Inthe Login — New form, under the General page, type in the Login Name and modify
the rest of the options according to your preference.

c. Openthe User Mapping page. Check the appropriate boxes to grant the new account
access to the Perspective database with the db_owner role membership rights, then

click OK.
E Login - New H=]
Selectapage ;50-‘1 o leEb
2 General
“4 Server Roles L.
A4 ser Mapping Users mapped to this login:
24 Securables Map | Database | User | Default Schema |=]
2 Stahys r miodel
¥ | PemspecliveZlSample | remnyakova _IJ
r ReportServer$SOLExpr_..
r ReportServer$SOLExpr... ll
I™ | Guest account enabled for: Perspective?] Sample
N ———
Server, [] db_accessadmin
BETA\SOLEXPRESS ™ db bad tor
Connection: [[1 db_datareader
INTERMAL \svetana remnyakon) | db_datawiter
) ) ) [ db_ddladmin
3¢ Wiew connection properties| | — 4 derpdat i
[ db_denydatavsiter
[1 db_securityadmin
Ready [ Pesspectivellseifiole
v public
0K I Cancel |
Vi

SQL Reporting Services

1. Ensure that SQL Server Reporting Services is installed.

2. From the Perspective install directory, copy the Reports Setup folder and all subfolders to a
temporary directory on the Reporting Services computer.
3. Editthe PublishServerReports.bat file in the temporary directory. Before making any

changes, save a backup copy of the original PublishServerReports.bat file.

o Edit databaseServerName to <Name_of Database_Server>.

o Edit databaseName to <Name_of Database>.

Edit databaseUserld to <sql_User_Account>.

Edit databasePassword to <sqlUser_Password>.
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4.

Save changes and run the PublishServerReports.bat file to publish reports to the Report

Manager. If the file fails to run, see the “Troubleshooting Tips” section.

£\ windows Server 2008 Warning

If installing on Windows Server 2008, the command contained in the batch file must be
run from the Administrator's Command Prompt window as this will require elevated
permissions. The command must be launched from the directory in which the batch

file is contained.
5.

a. On the Contents tab, click the Perspective folder.

Browse to your Reporting Services Web site (e.g., http://localhost/Reports/).

b. Click Properties, Security and New Role Assignhment, then Edit Item Security.
/_‘.‘ Report Manager - Windows Internet Explorer [_ O] =]
@A' Ig http:,l’)’IocaIhost,l’Reports,iPagas,l’Foldar.aspx?Ilj L[] > I:’LiveSearch Folbs
File Edit Wiew Favorites Tools  Help
T:? Favarites @Repnrt Manager | |

) SQL Server Reporting Services Home | Help d
I_j Home > Search for:l Go
“  Perspective
X Delete || 47 New Rolen_Asswgnment| [ Revert to Parent Security
General Ay
Security - Group or Userd Rale(s)
[T Edit BUILTIN“Administrators Content Manager
[T Edit BUILTINYUsers Content Manager
C.

Enter a Service Account for the Perspective application to use when connecting to

Reporting Services. Create a new local user, if you do not have one already. Ensure

that the password is not set to expire.

d. Select the Browser role and click OK.

ﬂ'.i Report Manager - Windows Internet Explorer

=1 E3

@A' |g http:,l’,l’Iocalhost,l’Reports,l’Pages,l’EditGroup.aspx'j W (| #4]| X I:’LiveSearch

File Edit Wiew Favorites Tools  Help

.7 Favarites & Report Manager | |
Home | Heln |
SOL Server Reporting Services
= . Search for: Go
Ig’e‘i_ New Role Assignment J

Use this page to define role-based security for Perspective.

Group or user name: [remnyakova

Select one or more roles to assign to the group or user.

C FRoled
Browser

Description

May view folders, reports and subscribe to reports.
Content Manager

resources,
My Reparts

users My Reports folder,
May publish reports and linked reports to the Report Server,
May view report definitions.

[
r
-
I~ Fublisher
I~ Report Builder
oK]

May manage content in the Report Server. This includes folders, reports and

May publish reports and linked reports; manage folders, reports and resources in a
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Perspective Services (Application Web Server)

Completing the following steps will install Perspective Services, Integration Services, Real Time
Services, and Web Portal.

% DTC Note
Perspective Integration Services requires the Microsoft® Distributed Transaction
Coordinator (DTC) service to be installed and enabled on the 1IS Web Server and the
Microsoft® SQL Server® for Perspective.

4 Enable IIS 6 Metabase Compatibility (image is taken from SQL server 2012).

Server Manager * Dashboard

WELCOME TO SERVER MANAGER
T Local Server
B8 Asservers = ‘Add Roles and Features Wizard BE |
¥R File and Storage S¢
Io 1is Select server roles

Select ane or more roles to install on the selected server.

Roles

L) Remote Desktop.

(ADS) APl:.

@ Manageability

Events

B e

Management S Performance

BPA results

[<Brevious | [ Nea> Cancel

£\ Ensure Internet Information Services (I1S) is installed, and that IIS has WCF Activation
turned on (image is taken from SQL Server 2012).

Server Manager

Add Roles and Features Wizard

SSTINATION SERVER
QANISOC 200

i

iz Al Select one or mere. il on the selected server.
L Features

o ~

(] NET Framework 3.5 Features
4 [ NETF F

ing
in application
bust,

. = N frver 1 Wi Al servers 1
lbility @® Manageability
< Breviows | | New:> Instal Cancel Events
G o e Services
BPA results Performance Performance Performance
BPA results BPA results BPA resuits
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1. From the Perspective Install > Web Service Setup directory, run (as an administrator)
Perspective.Services.exe. To complete the setup, follow the wizard's guidelines.

a. If the User Account Control screen pop-up window appears, click Yes.

Program name:  Perspective Services
File origin: Metwork drive

(%) Show details [(w ]

This file is in 2 lecation cutside your local network, Files from locations you don't
recognize can ham your PC. Only run this file if you trust the location.

hange when these n ion: r

b. Wait for the Perspective Service Setup Wizard to start. Click Next.

Installing Perspective 4.0 Services
The program features you selected are being instaled,

Please wait while the InstalShield \Wizard instals Perspective 4.0 Services,
This may take several minutes.
Status:
Copying new files
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i‘._% Perspective.Service - Installshield Wizard

Welcome to the InstallShield Wizard for
Perspective.Service

4> Perspective

The Installshield{R) Wizard will inskall Perspective. Service on
wour computer, To continue, click Mext,

WARMING: This program is protected by copyright law and
international treaties,

< Back I Mexk = I Cancel |

c. Read the License Agreement. If you accept the terms and conditions, select the
appropriate radio button, and click Next.

{ig Perspective.Service - Installshield wizard

License Agreement

Please read the Following license agreement carefully,

PPM 2000 Inc. 3
Software License Agreement

THIS SOFTWARE LICENSE AGREEMENT APPLIES TO THE FOLLOWING SOFTWARE
PRODUCTS:

Ferspective by FPW 2000™ - AR Edition

FPerspective by PPM 2000™ - S0C Edition

Perspective by PPM 2000™ - [CMW Edition

Perspective by PPM 2000™ - EIM Edition

Perspective Focal Point™ j

& 1 accept the terms in the license agreement: Print |

€~ 1do nat accept the terms in the license agreement

Imstallstield

< Back I Mext = I Cancel |

d. The default install path for the Complete install is C:/inetpub/wwwroot/Perspective.
Ensure Complete is selected, and click Next.

10
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i Perspective.Service - InstallShield Wizard

Setup Type

Choose the sebup bype that best suits your needs,

Please select a setup bype.

{* Complete

Al program Features will be installed. (Requires the most disk.
SPACE. )

" Custom

Choose which program Features you want installed and where they
will be installed. Recommeanded For advanced users,

Imstallshield

< Back. I Mexk = I Zancel |

e. Inthe following screen, click Install to confirm the installation. Wait while Perspective
Services is being installed.

ii|2!r1' Perspective.Service - InstallShield Wizard

Ready to Install the Program .
The wizard is ready to beqin installation, [

Click Install to beqin the installation,

If wou want ko review ar change any of your installation settings, click Back. Click Cancel ko
exit the wizard.

Installshield

< Back I 1Hg Instal I Cancel |

f. If Visual C++ 2010 SP1 Runtime Libraries (x64), .NET Framework 4.0, and .Net
Framework 4.5 is not installed, you will be prompted to install the Runtime Libraries
and/or .NET Framework. If they are already installed, skip to step 2i.

Note: As of Perspective Version 3.3, the full Microsoft .NET Framework 4.0 pre-requisite
installer is bundled into the Perspective installer. .NET Framework 4.0 is required; if it is
not yet installed, it can be done so as part of this installation process.

11
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The program features you selected are being instaled.

Pleaze walt while the InstallShield Wizard instals Perspective 4.0 Services,
This may take several minutes.

Status:
Installing Microsoft Visual C++ 2010 5P1 Redstributable Package (x54)

Welcome to Microsoft Visual C++ 2010 x64 Redistributable Setup
Please, accept the license terms to continue.

MICROSOFT SOFTWARE LICENSE TERMS

MICROSOFT VISUAL C++ 2010 RUNTIME LIBRARIES WITH
SERVICE PACK 1

These license terms are an agreement between Microsoft
Corporation (or based on where you live, one of its affiliates) and
you. Please read them. They apply to the software named above, ..

[T have read and accept the license terms.

["]ves, send information about my setup experiences to Microsoft Corporation.

For more information, read the Data Collection Policy,

| sl | [ concel

When the installation is complete, click Finish.

12
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Installation Is Complete

Mcrosoft Visual C++ 2010 x54 Redistributable has been
installed.

You can check for more recent versions of this package on
the # Visual Studic website,

Installing Perspective 4.0 Services
The progrem feabures you sslected are being irstaled,

Flease want while the InstaliShield Waaerd instals Perspective 4.0 Services.
This may take severd minutes.

j-  Click Finish once the installation is complete.

e  Only check the Show the Windows Installer log box if you want to see where the
files have been installed.

13
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i'-:il Perspective.Service - InstallShield Wizard

InstallShield Wizard Completed

The Installshield Wizard has successfully installed

Perspective,Service, Click Finish to exit the wizard,

[ show the Windows Installer lag

= Back I Finish I

Zancel

Configure Connections Using Service Manager

1. From the Perspective Install > Web Service Setup directory, run (as an administrator)

Perspective.ServiceManager.exe.

a. The prepare for installation screen appears.

b. If the User Account Control screen pop-up window appears, click Yes.

2. The installation wizard appears; click Next to continue.

{i# Perspective 4.0 Service Manager - Installshield Wizard

Welcome to the InstallShield Wizard for

: e Perspective 4.0 Service Manager

The Installshield{R.) Wizard will install Perspective 4.0 Service

Manager on your computer, To conkinue, click MNext,

international treaties,

WARMING: This progran is protected by copyright law and

= Back I Mt = I Cancel

14
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c. Read the License Agreement. If you accept the terms and conditions, select the
appropriate radio button and click Next.

i'é" Perspective 4.0 Service Manager - InstallShield Wizard

License Agreement

Flease read the Following license agreement carefully,

PPM 2000 Inc. ﬂ
Software License Agreement

THIS SOFTWARE LICENSE AGREEMENT APPLIES TO THE FOLLOWING SOFTWARE
PRODUCTS:

FPerspective by PFM 2000™ - AIR Edition

Ferspective by PP 2000T™ - 500C Edition

Ferspective by PP 2000T™ - |G Edition

Ferspective by PP 20007 - EIM Editian

FPerspective Focal Point™ j

& T arcept the terms in the license agreement: Print |

I do not accept: the kerms in the license agreement

Installshield

< Back I Mext = I Cancel |

d. Select the appropriate installation directory. Click Next.

{iF Perspective 4.0 Service Manager - InstallShield Wizard

Destination Folder

Click Mexk boinstall ko this Folder, o click Change toinstall ko a different Folder,

Install Perspective 4.0 Service Manager to:

Ci\Program FilesiPPM 2000 InciPerspectivel 4. 0iServiceManager!, Change. ..

Imstallshield

< Back

Cancel |

e. Inthe following screen, click Install to confirm the installation. Wait while Perspective
Service Manager is being installed.

15
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|§ Perspective 4.0 Service Manager - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation,

Click Install to begin the installation,

IF wou want ta review or change any of wour installation settings, click Back. Click Cancel ko
exit the wizard,

Imstallshield

< Back

Cancel |

f.  Click Finish once the installation is complete.

e  Only check the Show the Windows Installer log box if you want to see where the
files have been installed.

i'-.a Perspective 4.0 Service Manager - InstallShield Wizard

InstallShield Wizard Completed
4> Perspective

The Installshield Wizard has successfully installed Perspective
4.0 Service Manager, Click Finish to exit the wizard,

[ show the windows Installer log

< Back

Zance| |

From the Start menu, or desktop, launch (as an Administrator) Perspective 4.0 Service
Manager.

Note: This process may trigger Windows' UAC (User Access Control) security feature. If
prompted, click Yes.

16
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4.

17

ﬁ_ﬂ User Account Control

Do you want to allow the following program to make changes to this
= computer?

| Program name: Perspective, ServerManager
I Verified publisher: PPM 2000 Inc
File origin: Hard drive on this computer

j Show details es | Mo I

Change when these notifications appear

If you changed the installation path, you may be prompted to select a Perspective
configuration file. Navigate to the installed location of Perspective Services, select the
Perspective_Default.config (default location:
C:\inetpub\wwwroot\Perspective\PerspectiveServices) and open the configuration file.

You'll be prompted for database information.

Database Connection E

Ferzpective |

Connection (D

IS ample
SOL Server
| ASUANZ/ALLNE2013 =l

¥ Frimary Connection

Drefaul Language D

1] -
" windows Authentication
¥ SOL Authentication
|l zername:
IF'erspective
Pazzwiord:
I. [ 111
D atabazes
Perzpective 40 Demo 5l
] Cancel

Enter a new name for Connection ID.

Note: The Connection ID cannot contain the word “Default”.
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10.

11.

12.

In the SQL Server lookup list, select your SQL Server or type the name of your server in the
text box.

Leave Default Language ID set to 0, unless instructed otherwise by PPM 2000.

Ensure SQL Authentication is selected, and enter the SQL Username and Password
created when installing the database.

Select your Perspective database from the Databases lookup list.

Note: If you receive an “Unable to connect to the named server” message, you have entered
either the wrong SQL server name or credentials.

Click OK to save and add the primary connection.

In the top field, enter your Company Name, as listed on the email provided to you with your
license keys.

Enter the Master Key that applies to the Company Name entered. Note it is case-sensitive.

Click the Validate button. The fields below will indicate the number of active licenses,
License Expiry Date, Product Level and specifications of individual Licensed Modules
(i.e., Product, Number of Users and Expiry Date).

Note: The Validate function will access a central licensing service hosted by PPM 2000 Inc.
Internet connection is required to download your license file.

Optional: If you do not have Internet connection available, you may contact Technical
Support for your license file and manually update it in the License Location field.

18
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8 Perspective Service Manager M= B3
Service Manager Settings |
C Name:
PPM
>4 Configuiation I
2 Master Key:
£ Dosbase [PPM541354X695435000

P ¥ Allow connections to Perspective License Service
‘f'/ Product Validation

p Quick Find Indexing Licensed To License Expiry:
- QA Advanced Security PCOREIM2S 124312099
User Defined Fields Product Level: Number Of Licenses:
Perspective EIM 25 Concurrent
Enterprise Incident Management
i, Downloads
‘ Product Expiry Date =
Visual Analysis
Mobile Web 12/31/2093
Case and Investigations 12/31/2088
Mobile &pple i0S 12/31/2093
Web Portal 12/31/2093
Save Cancel
9/10/2013

Note: The Allow connections to Perspective License Service box is checked by default.
Unchecking this box means a license file must be imported when the Validate button is pressed.
A license file can be obtained from PPM 2000 Support.

13. Open the Database component from the menu on the left and double-click your database
name, or click the Edit button.

14. Open the Report Service tab and type the report server URL in the Report Server URL
box.

15. Enter the name of your Reports Folder.

16. Proceed to the Report Service User section below. Enter the Domain, Username and
Password that were granted browser rights when setting up the server-side reports.

17. Click the Test button. You should receive a prompt telling you the URL is valid. If not, then
double-check that your configuration is correct and try again. If you keep receiving an error
message, please call the Technical Support team at 1-877-776-2995 for assistance.

18. Click OK.
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19.

20.

21.

22.

Database Connection ]

Perspectivel fnalyzis Expert Connection  Fepart Service I.-’-\uthentic:atiun Mndel

Report Service Host
Report Server URL

|http:fﬁmﬁerVBrfrepnrtsewer Test... |

Fieports Folder

IPerspective{

— FRepart Service Uzer
Diamain

|User_D ornain_Marme

Username

|User_Login_Name

Fazzword

] Cancel

Select the Configuration component from the Perspective Service Manager menu.
To encrypt the Perspective_Default.config file, check the Encrypt Configuration? box.
Open the Client-Side Configuration tab.

Enter the Download URL for Client-Side Reports, if needed, for the client reports
configuration files to update automatically (i.e., http://<server
name>/perspectiveservices/client).
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23.

24.

25.

/ Configuration __-]{ Client-Side Configuration T Motification r Attachments ] Sewices] AE Tools l

Client Reports Configuration

Download URL for Client-Side Reports:
[htlp:h’Iocahcst.-"pempecﬁvesewicesfclienu

Location of updated client-side reports:

| Browse__|

r Reports Exists On Senver

Client-Side Reports Versi...

401126

Save Cancel

Click Save.

Note: If you do not click Save, you will be prompted to Save all changes that have been
made.

Then, close the Service Manager by clicking the Cancel button, or clicking the X button on
the caption bar.

Restart IIS.

Advanced Configurations Warning

Many options in the Service Manager are not covered in this step-by-step Standard Install
walkthrough. For the list of supported advanced setup configuration options, please, refer
to the “Advanced Configurations” section that appears later in this guide. It is
recommended that all setups follow the standard setup procedures outlined in this section
as an initial starting point. Advanced features can then be configured as needed, after the
standard setup is running and connections have been verified.

Real Time Service Configuration

If you have Dispatching, you need to do additional configuration to Real Time Services.
Dispatching is available in Perspective SOC and EIM.
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1. Navigate to your lIS Settings.

2. Expand Site, expand Default Web Site, right-click PerspectiveRealTime, go to Manage
Application, and click Advanced Settings. In Advanced Settings, add http,net.tcp in Enabled
Protocols. Click Ok.

LS| Internet Information Services (IIS) Manager [=la] x|
® |J » QA01250C + Application Pools Advanced Settings Eehoe-
File View Help 4 (General)
g'il Appli Physical Path Cinetpub\wwwroot\PerspectivelSel .
Q-Hi iz e ? Physical Path Credentials & Add Application Pool..
; gf Start Page This page lets youf Physical Path Credentials Logon ClearText lociated with Set Application Pocl Defaults...
-5 PPUZ00023X wortker processes, Preload Enabled False 3 Application Pool Tasks
1|2} Application Pools i p . .
e = Virtual Path PerspectiveReaTime P star
481 Sites 4 Behavior E
4 4l Default Web Site Name 5 e oloCOk: ttp.nettcpl [Applications ! o
b (5] aspret_client D NET w5 na rotocols ttp,net.tg b & Recyde..
» @ IntegrationServices | 2} NET w5 Cla] b Edit Application Pool
p-E "er!Pedjve L} DefaultAppPof i =l Basic Settings...
3 L: PerspectivePortal D integrationse 4 Ry
z o ;::P:::::E::LT;: JPerpsectiveRe 1 Advanced Settings...
i Persp ‘?Pﬂ:peniw% i Rename
IPerspectiveSef i % Remors
View Applications
@ Help
Online Help
| Enabled Protocols
Enabled Protocols specifies the protocols that requests can use to access an
application. The default value is 'hitp', which enables bath the HTTP and ...
< - >
< O 3] [0 Features View |
Ready .

3. Port 808 will be used by default.

4.  Go to inetpub/wwwroot/Perspective/Perspective Services directory, and edit the Perspective
Default Config file. To do this, find the Perspective Real Time URL, and replace the
localhost with a fully qualified server name.

Note: Additional settings for firewall may be required.
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Client Machines

Accessing Perspective Desktop Client

1.

2.

23

Ensure Microsoft .NET 4.0 Framework is installed on the client machine.

Browse to the Perspective Services URL: http://<lISServer>/PerspectiveServices.
“lISServer” refers to the Perspective Web server installed in the previous section.

a. Click the Launch Perspective button.

A\ Perspective

by PPM 2000
Perspective Version 4.0

Launch Perspective

.Met Framewark 4.0 needs to be installed to launch this application.

If you do not have the .NET Framework:
Click here to download .NET Framewark 4.0 from Microsoft

b. Inthe dialog box that opens, click Run.

Note: If you are using the MSI Package installer, follow the procedures below.

Browse to the Perspective Services URL:
http://<lISServer>/PerspectiveServices/default.aspx?opt=2

If you are using ?opt=1, only the Click-Once installer will be displayed.

If you are using ?opt=0 or if Java Script is disabled or the Web Service is not a
trusted site, both the Click-Once and MSI Package installer will be displayed.

Click the “Click here to Download MSI Package” and follow the on-screen
instructions. If you experience any problems during the download of the MSI
Package or the installation of the MSI client, please call the PPM 2000’s Technical
Support team at 1-877-776-2995 for assistance.
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A\ Perspective

by PPM 2000
Perspective Version 4.0

Launch Perspective

.Met Framewaork 4.0 needs to be installed to launch this application.

If you do not have the .NET Framework:
Click here to download .MET Framework 4.0 from Microsoft

After Perspective downloads and installs, you might be prompted to enter a URL. The URL
should be automatically populated; if so, move to the next step. If not, enter your
Perspective Services URL as before: http://<lISServer>/PerspectiveServices. <lISServer>
refers to the Perspective Web server installed during the installation of Perspective.

Now you should be able to test the default Perspective logon. From this point onward, users
must navigate to the Perspective Services URL to launch the Perspective application.

Perspective Default Logon

User Name:  Admin
Password: Security

To create a shortcut to the application on the client machine’s desktop, proceed as follows:

1.

2.

3.

Navigate to the Perspective Services URL.
Right-click the Launch Perspective button and select Copy Shortcut.

Right-click the client desktop and select Paste Shortcut.

Default Admin Master vs. Users with Administrator Rights

As of Perspective Version 3.3, there are differences between the default Admin Master
account and a Perspective User with Administrator rights. Specifically, the Admin Master
has select features available that other Users, even with Administrator rights, do not.

However, the default Admin Master can only access the Administration and
Dashboard panels of Perspective. Other components are unavailable to the Admin
Master; this account cannot be used for data entry.
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Accessing Perspective Web Portal

Users cannot access Portal until an Administrator has installed the service and set up
workgroups. The following steps explain how to do this:

1. Open an Internet browser.

2. Navigate to your Portal Services URL: http://<IISServer>/PerspectivePortal. <lISServer>
refers to the web server installed during the installation of Portal.

3. Administrators will be required to log in to set up the Web Portal. Refer to the Perspective
Web Portal User Guide for additional information.

Testing Perspective Implementation

Once you have completed the steps outlined on the previous sections, please go through the
following steps to ensure that all Perspective’s components have been set up properly.

1. Goto the Perspective Services URL and confirm that the page loads
properly: http://<localhost>/perspectiveservices.

2. If the above fails, go to the Perspective Services page and confirm that the page loads
properly: http://<localhost>/perspectiveservices/service.asmx.

3. Go to the Reports page and confirm that the page loads properly:
http://<reportservername>/reports.

Note: If your Reports page does not display correctly, run the PublishServerReports.bat
file included in the Perspective Install > Reports Setup folder.

f_'; Report Manager - Windows Internet Explorer H=]
@“ ¥ |g http:,I',l'Iocalhost,l'Reports,l'Pages,l’Folder.aspx?'v'iej @ || & I:’ Live Search Pl

File Edit Wiew Faworites Tools  Help

{3 Favarites @ Repart Manager | |

Home | Site Settings | Help |« |

I_._ SH%Lnieerver Reporting Services S earch for: I—M
Ll
[ yMew Folder <3Mew Data Source L] Upload File 22 Show Details

[ Perspective

=

4. Log on to the Perspective client—preferably not on the server itself—using your Perspective
Administrator user name and password.
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Once you have logged on successfully, click on the Reports button in the Navigation pane
(on the left-hand side of the screen) and confirm that all reports are listed. The easiest way
to confirm that the client-side reports are working is to verify that there are reports listed
under the <Detail Reports> heading, such as the Incident, Person and Vehicle Reports. Try
to run any of the reports by clicking Preview.

To confirm that the server-side reports are working, try running the Test Report under the
<Administrative Only> node. If you receive an error message, please call the Technical
Support team at 1-877-776-2995 for assistance.

Note: The Report version should display as 4.0, while the Database version should display
as 3.3.0.
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Advanced Configurations

""""""""""""""""" With Perspective, your organization has a number of advanced configuration options available.
Before attempting to implement any of the following options, we recommend that you complete
the standard installation first; then, contact Technical Support (support@ppm?2000.com) for
further instructions.

SSL on Your Web To secure and encrypt data sent to and from the Web service to
Service client machines.

To allow users to log on to Perspective and to connect to SQL

Windows Authentication ) . L .
service using their Windows authenticated account

To compress information sent from Web services to the client.
(Recommended for installs with remote users who are not

IIS Compression connected directly to the network. If all users are internal,
compressing data may take longer than sending uncompressed
data over a high-speed network.)

Transparent Data For encrypting data at rest (for use with Microsoft SQL Server
Encryption (SQL 2008) 2008 Enterprise Edition only).

Setting up Default setup supports one database only. If additional databases
Sample/Training are required, these can be set up with assistance from Technical
Database Support.

For sites with high volumes of data that require SQL intensive

AE Mirrorin .
d searches to be executed against a separate SQL server.

By default, the pagination feature is set to 100 records per page.
This number can be modified (to any value from 20 to 1000
Custom Pagination records per page) by manually editing the
<PaginationPageSize>100</PaginationPageSize> tag in the
Perspective_Default.config file.

To customize Perspective’s legal notice and/or privacy statement
for your organization, navigate to the Legal folder in the

Custom Legal Notice Perspective Services Virtual Directory, open the LegalNotice.mht
and Privacy Statement or PrivacyStatement.mht file in an HTML editor (such as
Microsoft Word), apply your edits, and save the file as an MHTML
document with the original file name.
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Change Default Install
Location

To change the default installation location, select Custom from
the Setup Type screen (when installing Perspective Services).

Click Next. Select a feature and click the Change button. Then,
pick the new install location. Click Ok.

Change Caching Options
of Portal

The caching duration is set by default to 20 minutes. However,
this can be changed by accessing the web config file of
Perspective Portal. The duration is in minutes, and can be
between 1-1400 minutes.

Note: Caching should always be enabled, unless you are
troubleshooting. Disable it by setting caching=false.

Directing to Fully
Qualified Servers for
Portal

Go to C:/inetpub/wwwroot/Perspective/PerspectivePortal and edit
the web config file. Find the external web address and update it
to a fully qualified server.
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Set Up Additional Features Using
Service Manager

Perspective Service Manager is an external application available only on the Web server
hosting Perspective services. It is used to manage configuration files, databases, licenses and
keys, as well as to set up a number of important features in Perspective (i.e., email and mass
notifications, attachments, Quick Find indexing, user-defined fields, Custom Search integration
and Integration Services URL).

To access Perspective Service Manager, go to C:\Program Files\PPM 2000
Inc\Perspective\4.0\ServiceManager, and open Perspective.ServerManager, or open it from
the Startup menu.

Remember to complete each editing action in Perspective Service Manager by clicking Save
Changes. To implement your settings in Perspective, restart Internet Information Services (1IS)
(and the Perspective Web server). Note that restarting 1IS will affect anyone currently logged on
to Perspective. Ensure that all users have saved their work and exited the program prior to
completing this step.

Configuration

Select the Configuration component from the Perspective Service Manager menu and open the
Configuration tab. Click Browse to navigate to the Location of Server Configuration File.

Note: This option would be used when Perspective Services has been installed in a different
location than the default option.

Configuration ] Client-Side Configuration ] Motification ] Attachments ] Services | 4
Location of Server Configuration File
Clinetpublwwwroot\Perspective\PerspectiveServices\Perspective_DEFAULT .config

[[]  Encrypt Configuration?

Advanced Security
Version: 401128

Client-Side Configuration

1. Select the Configuration component from the Perspective Service Manager menu and
open the Client-Side Configuration tab.
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2. To update the configuration with a .zip file provided by the Technical Support, click Browse
to navigate to the Location of Updated Client-Side Reports. The field below will indicate
the Version of the client-side reports.

3. Click Update Reports to Server to complete the update.

Note: This option would be used if a newer version of client-side reports is available.

/ Conhiguration ) Chent-Side Configuration \ Notﬁcdionl Anadwlsl Setvioe:l AETookl
Chent Reports Configuration

Download URL for Chentside Reports

{hitp: /7 servemame> Jpetspectiveservices/chent/

Locabon of Updated Chentside Reports:

I Browse I
I™ Reports Exist on Server

Chentside Reports Version

{4.0.1128

Save Changes Ext

Note: 'xxxx" in the above screenshot denotes the latest Perspective build number.

Email Notifications

In Perspective, users may send email notifications containing incident or case details or report
attachments. Otherwise, email notifications may be sent, when new investigators are assigned to
an investigation, or when assignments are created, modified or completed.

Note: The Case and Investigation components are only available in the Perspective Premium.

To set up email notification options, select the Configuration component in the Perspective
Service Manager menu and open the Notification tab.

There are two options for configuring email settings in Perspective: Outlook® or SMTP
integration. Alternatively, email functionality can be disabled by selecting the “Do not use mail
options” radio button.

Option A: Outlook Integration
Select Outlook (only) to order Perspective to utilize the active user’s local Outlook 2007 or 2010

client to send emails. These emails are sent through the central Exchange Server and stored in
the user’s Sent Items folder.
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Option B: Connect to an External SMTP Server

To use an SMTP server to send emails from Perspective, switch the radio button from Outlook to
SMTP and enter the appropriate information for connecting to the SMTP server:

31

Host: The domain name of the SMTP service.

Port: The port the SMTP service will be listening on for connections.
Username: A valid user name to connect to the SMTP service.
Password: The appropriate password for the user name.

Use Default Credentials: Rather than entering a particular user name and password, you
can specify that a user’'s Windows credentials be used to connect to the SMTP service.

Use Anonymous Access: As an alternative option, if the SMTP server does not require
user credentials to connect and send email, you can enable users to connect anonymously.

Enable SSL: Select this option to encrypt the SMTP connection with Secure Socket Layer
(SSL).

Reply Address: When sending email messages, the SMTP service must include a reply
address. Enter the email address that you would like to appear on any email messages sent
via SMTP.

The email settings outlined above will be used as system defaults for every client. With the
exception of the reply address, all of these settings can be overridden for individual clients
by specifying alternative settings under the client’s Settings > Options menu in
Perspective. (The reply address is a global setting and will be used for anyone using
SMTP.) If you do not want individual clients to have the option of overriding any of these
settings, select the “Force all clients to use these settings” box.
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i

Configuration r Chent-Side Configuration /Nuﬂicalim r.ﬁttachm rSBF'.’iDE:S ’/AETDDIS

" Da not use mal oplions

" Outlook 1, Meotification works on 32 bit Outlock only

& SMTP -

Haost: Imalexample.cu:um

Pott  [12345

Usemame: ||

Password: |

™ Use Default Credentials | Use Anongmous Access
™ Enable 55L

Reply Address: Imteplj.l@ppm2ﬂﬂﬂ.cu:um

™ Force all clients to use these settings

Save Changes E st

Uploading Attachments

Perspective allows users to attach any file type to any data record in the application. These files
are stored directly in the SQL database and their size can be the greatest factor in determining
how much space will be required in SQL.

To set up the maximum attachment size, select the Configuration component in the Perspective
Service Manager menu and open the Attachments tab.

Perspective can support files up to 2 GB in size (SQL’s limit for binary data types); however, due
to restrictions you may have on the space available for your Perspective database or bandwidth
in your network, we do include an option to decrease this 2-GB limit to a size that can be better
supported in your environment.

. On SQL Standard or Enterprise, this value can be set between 1 MB and 2000 MB. The
default is set to 250 MB.

. On SQL Express, this value can be set between 1 MB and 50 MB. The default is 10 MB.

Note: SQL Server Express is only supported for the Standard Edition of Perspective.
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To change this value to an appropriate value for your organization, move the slider.

Specify mawimum allowed attachment size for the clent.

S

M aw attachment size: 250 MB

[Upper limét is 2GB for SGL Server 2005/2008 and S0ME for SOL Express)

Save Changes Exit

Integration Services URL

To enable event trigger in Integration Services, select the Configuration component from
the Perspective Service Manager menu and open the Services tab.

Enter the URL set up with the Integration Services in the Integration Services field.

To enable trigger events on create and update, check the “Enable Trigger Notification”
box. To enable context-sensitive events, check the “Allow Hot Key Events” box.

/Conﬁwration /Cliem-SideConﬁguraﬁon] Notification /Anachmena/Servim rAETools

) ¥

Integration Services
[https://staging ppm2000.com/IntegrationServices3(|

[T Enable Trigger Notfication [T Allow Hot Key Events

PPOVIVV SOOI OOOIOIIOIOIe
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Save Changes Exit
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Custom Search Integration

With Perspective’'s Custom Search feature, you can integrate Perspective with the Infoglide
Identity Resolution Enginem (IRE) to search several data sources at once. Complete the following
steps to enable this integration. Note that you must first configure your Perspective database
within the Identity Resolution Engine before proceeding.

To set up the Custom Search feature, select the Configuration component from the Perspective
Service Manager menu and open the Services tab. Check the “Enable Custom Search (with
Infoglide)” box and enter the URL for the Infoglide Identity Resolution Engine in the field below.

Note: To access the Custom Search feature, users must be granted the appropriate access rights
in Perspective. For details on administering Custom Search access for roles and users, see
“Select general role rights” and “Set general user rights” in the “Roles” and “Users” sections of the
Perspective Administrator’s Guide.

! .Eﬂiﬁﬂﬂlﬁﬂl ] .Ehﬂ-%ﬁm-lﬁm ] Hwﬁ:m ] w}m l .AETH‘I l

Integration Senaces
frizns ./ Stagng ppm200 com Tnbegraton Senvices

™ Enable Trgoer Motfication ™ Allows Mot Kary Everts
¥ Enable Custom Search fwith Infoghde]™
Il'ﬂ'pr'."ﬂw.mdnllccﬁl

A A Y S

Save Changes Egt

Mass Notifications

In Perspective, users can integrate their MIR3®" inEnterprise™ solution into Perspective in order
to send mass notifications about selected activities via Perspective DispatchLog.

To set up the Mass Notification feature, select the Configuration component from the
Perspective Service Manager menu and open the Services tab. Check the “Enable Mass
Notification (with MIR3)” box and enter the Mass Notification URL, Username and Password
provided by MIR3 in the field below.
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 Services || AE Tools

/Cw:ﬁgumﬁon] Gieﬂt—ﬁde(:mﬁumﬁon] Noﬁﬁcaﬁun' Attachments

Integration Services
Im:ffﬁagmg.ppmm.cummmm&mcas 30

™ Enable Trgger Notfication ™ Allow Hot Key Events
™ Enable Custom Search fwith Infoghide)”

¥ Enable Mass Motification fwith MIRZ)
Mass Notification L
IMp:f;’nwebseMcea.mir3-.cumf5ewioes.fvl.2}mtr3

Usemame: [QATest
Password:; I- Il

* Custom Search should not be enabled unless integrating an extemal search tool
from Infoglide to search several data sources at once.

Save Changes Exit

Analysis Expert Tools

If you experience difficulties with the correct Analysis Expert (AE) query display, this function
must be used to update the AE .dat file provided by the Technical Support.

1. Select the Configuration component from the Perspective Service Manager menu and
open the AE Tools tab.

2.  Specify the SQL Server.

3.  Select either the Windows or SQL Authentication. If you selected SQL Authentication,
enter the correct Username and Password.

4.  Choose the Database you wish to update your queries on.

5.  Specify the correct path to the AE .dat file provided by the Technical Support in the File
Location field.

6. Click Update.
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Configuration r Client-Side Configuration ’/ Metification r Attachments rServim / AE Tocls

r— Database Connection
SQL Server: [4658GD1 7

& Windows Authentication
SQL Authentication

Lsemame: I

Password: I

Databases: |Perspective j

B

— AE Filz Location

File Location: I"‘-"'\DDI'I'IZDDH |

Update

|Save Changes ‘ Exit

Quick Find Indexing

With Perspective’s Quick Find tool, you can quickly search for text anywhere in the database,
including text within attachments. This works by scanning an index file generated on the server.

1.

To set up indexing on your database, select the Quick Find Indexing component in the
Perspective Service Manager menu.

To enable this feature, select Allow Quick Find.

Select an Index Directory to store the index files. IIS must have access to read this
directory.

Optional: If large index files are expected, you can force the index cache to use a separate
directory by checking “Specify folder in alternate drive to store cache while indexing?”
and then selecting a directory.

Optional: If you would like certain common words to be ignored when indexing (e.g., a, the,
an, at, to, etc.), select “Use noise word file?” and specify the directory where your
Noise.dat file exists.

Optional: If you would like hyphenated words to be indexed as two separate words, you can
select “Treat hyphens as spaces”.

Optional: If you would like the index files to ignore any numeric text, you can select “Do not
index numeric values”.
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10.

11.

12.

13.

14.
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Optional: Select the Incremental Indexing box if you want your indexes to be built
incrementally.

Select the Database you want to index.

Expand the nodes listed under Tables and select each table you want data to be indexed
from individually. Note that attachments are indexed separately from the main entities and
can be found at the bottom of the list.

Click Save Changes.
Click Index to do an initial index of the database.
Optional: Repeat steps 8-11 for additional databases.

As data is added, deleted, or modified in the database, the index must be kept up-to-date.
You can schedule the database to re-index using command line arguments and Windows

scheduled tasks. To do this, create a scheduled task to run Perspective.ServerManager.exe

with the option -index= (or use the shorthand -i=) followed by the Database ID.

For example:
C:\Program Files\PPM 2000 Inc\Perspective Services\
Perspective.ServerManager.exe -i=Sample

Allow Quick Find
Index Directory

C:Anew 1\Primary

[] Specify folder in atemate drive to store cache while indexing?
[] Use noise word file?

Database to Index [] Treat hyphens as spaces.

| Primary v | [[] Do nat indest numeric values.

Incremental Indexing

Table To Index

i-- Investigations ~
[V Cases
Persons
Organizations
Vehicles

- [w] Attachments e

Index Progress

Powered by dtSearch®  www dtsearch.com

Save | | Cancel
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User-Defined Fields

Although user-defined fields (UDFs) can only be created by specialized users with access to both
the server machine and the Service Manager, they are maintained by Administrators in the same
manner as all other fields within Perspective. Visibility and access rights to a user defined field
can be controlled under System Privileges, Role Privileges or User Privileges. UDF labels can be
modified and created for other languages under Form Labels. Moreover, if the UDF is a lookup
field, lookup values and workgroup visibility for these values can be customized under Lookups.

You may add user defined fields to the Item, Person, Organization and Vehicle forms under the
General tab, as well as to numerous sections of the Incident and Case forms.

Note: The case component is only available in the Premium Edition of Perspective.

1. To set up user defined fields for Perspective, select the User Defined Fields banner at the
bottom of the Perspective Service Manager menu and open the General tab.

2. Inthe Server Authentication section, specify the Database Name. Ensure that this
information is correct before proceeding. The Form lookup list will become available.

3. From the Form lookup list, select the data form in which you would like the new user
defined field to appear. Your options are as follows:

e Incidents

e Incident Items (Involved Items)

¢ Incident Organizations (Involved Organizations)
e Incident Persons (Involved Persons)

¢ Incident Vehicles (Involved Vehicles)

. Items

e Organizations
e Persons

e Vehicles

e C(Cases

e Activities

4.  From the Section lookup list, select the specific section of the form that you would like the
user defined field to appear in. For all forms except Incidents and Cases, the only option
available is the General tab. For the Incidents form, you may choose the General,
Investigations (Details) or Controls tab. For the Cases form, you may choose either the
General or Controls tab.

Note: The Investigations tab is only available in the Premium Edition of Perspective.
5.  Click the Add button at the bottom of the window. An Add UDF dialog box will open.

6. Enter the new user defined field’s name in the Field Name text box. Note that no special
characters or spaces may be used—lIetters only. Then, assign the field its default System
English Label. The System English label is what users will see on the Perspective form.
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7. Choose the field type from the Data Type lookup list. The available field type options for
UDFs are Number [for whole numbers], Decimal Number [for numbers with up to two
decimal places], Text, Date, Yes/No [for a checkbox field] and Lookup List. If you selected
Text as the data type, you may also specify the maximum number of characters that can be
entered in the field under Text Length.

8 Perspective Service Manager [_ [ =]
Service Manager Settings D atabase:
: ISampIe j Frimary Connection
Y Eoii
«  Configuration
. Farm Section
? o IIncidents j IGeneraI j
General | Layout
:‘5 Product Validation Field M ame | Label Type | Required
p\ Guick Find Indexing
User Defined Field:
ﬂ Downloads
Plzagze do not farget to restart the Perspective web Add UDF Edit UDF I Delete |
zerver after making changes.

Save | Cancel |

11482012
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Not Recommended: If you wish to make the user defined field a required field, check the
System Required box. If you check this box, you will not be able to adjust the field-level
security at any point in the future. If you wish to make the user defined field required, it is
best to do so within Perspective at the system, Role or User levels. This allows greater
flexibility for the future use of the field.

Click Apply. The user defined field’s details will now appear under the General tab.

Add LDF

Field Name Label

[ aitatShatus [ avital Statues
Data Type Teut Lengih

| Lockup List ENE =
[ System FRegured
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To edit the user defined field, click the arrow to the left of the Field Name to select the entire
row and click the Edit button. Make changes in the Edit UDF dialog box and click Apply.

To delete the user defined field, click the arrow to the left of the Field Name to select the
entire row and click the Delete button. A Delete UDF confirmation window will open warning
you of potential loss of data. If you choose to delete the selected UDF and click Yes, any
data previously tracked in the UDF will be erased as well. Instead, it is recommended that
you hide or lock the UDF within Perspective, if you no longer wish to use it to track data.

10. To view the user defined field with its default form location, select the Layout tab. The Top
and Left values indicate the number of pixels that the UDF will be located from the top left
corner of the User Defined Fields section of the form. The User Defined Fields section
always appears at the bottom of the form.

Farm Section
IIr‘u:iu:Ient Perzonz j IGeneraI j

General | Layout

udrhd aritalS tatus

Top: 100 - Left: 210

Diefault Layout Prewious Layout | Save Layout {_: I

Click and drag the UDF label to move the UDF to an alternative location on the form. The
entire scrollable window beneath the Layout tab is representative of the User Defined Fields
section of the form. Click Save Layout to save the chosen UDF location on the form.

At any time, you may click Default Layout to return the UDF to its original assigned position
on the form. To return the UDF to its last saved location, click Previous Layout.
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Troubleshooting Tips

Event Viewer

When an error occurs in your Perspective session, first check Event Viewer to see if it has been
recored here.

1. Gointo Windows™ Event Viewer.
2.  Click the Windows Logs folder.

3. Click the Application sub-folder. Most errors that have occurred in Perspective will be
logged here.

Perspective Server

@ Ensure Perspective Services are set up

1. Open IS manager, navigate to the Perspective Services Virtual Directory, and try to browse
the Service.asmx file.

2. If the page that is displayed reads “Service”, the install was successful.
If you get an error code page:

a. Check the properties of the Perspective Services Directory and ensure it is running
under Microsoft .NET 4.0 on the ASP.NET tab.

b. Re-install Microsoft .NET 4.0 with ISS using the following command line:
C:\WINDOWS\Microsoft. NET\Framework\v4.0.30319\aspnet_regiis.exe

% Connect to the database using ODBC

1. Select Control Panel > Administrative Tools > Data Sources (ODBC), and open the System
DSN tab.

2. Click Add to create a data source, select SQL Server. Click Finish.

3.  Enter the name “Perspective” and select the name of your SQL Server.
4.  Click Finish, and then click Test Data Source.

@ Test the application pool

An application pool is used to connect to the database server. To test if there is an issue with the
Web application pool, change the account to Network Services and see if it runs.
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@ Restart IIS

Right-click your Computer icon and select Manage. Expand the Services and Applications
folder and right-click Internet Information Services (11S). Select All Tasks, then restart IS and
click OK. Another way to restart 1IS is to run the command line issreset from the Start menu.

Database Server

@ Ensure that the database login account has been assigned DBO access rights
1. In Enterprise Manager, select Security > Logins.

2. Double-click the domain user account that the Perspective server uses to connect to the
database (e.g., the test account “PerspectiveDBCon”).

3. Onthe Database Access tab, select the Perspective database and ensure that dbo access
is assigned.

@ Ensure that your database is in compatibility mode for a SQL version other than SQL 2000

In the Compatibility Settings in your SQL Database, ensure that your database is in compatibility
mode for a SQL version other than SQL 2000. If it is not, follow the steps below:

1. Open the Microsoft SQL Management Studio and expand Databases.
2.  Right-click on your Perspective Database and select Properties.
3. Onthe left-hand column, select Options.

4. Inthe Compatibility level field, select SQL 2008.

Reporting Services Server

For assistance and information on setting up SQL Reporting Services, view the deployment
guide on Microsoft’'s Web site: http://technet.microsoft.com/en-us/library/ms159868(SQL.90).aspx

@ Check the version of the Microsoft .NET Framework

If .NET Framework 3.5 is enabled on the machine, only client-side components of Reporting
Services will be installed. If necessary, remove the .NET Framework 3.5 before installing
Reporting Services, and re-install 3.5 afterwards using the following command line:
C:\WINDOWS\Microsoft. NET\Framework\v2.0.50727\aspnet_regiis.exe

@ Specify path for .bat file

1. Using the Windows Start menu’s Search function, search for the rs.exe file.
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2.  Place a copy of the rs.exe file in the Perspective Install > Reports Setup folder.

Perspective Client

@ Connect to the Web site

Open your Web browser and enter the following URL:

http://<IIS Server Name>/PerspectiveServices/Service.asmx

@ Ensure SQL login account is configured properly

The SQL login account (e.g., the test account “PerspectiveDBCon”) needs permissions.
@ Troubleshoot Windows authentication issues

If you are having issues with the Active Directory® single sign-on authentication, verify that the
Server service has been started on the Web Server.
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. (@) Performance sharing aver the netwark for this . Security Accounts... Thestartup .. Started Automatic Local Syste.., More Actions
o . computer. If this service is stopped, %4 Security Center The WSCSV... Started Automatic (D, Local Service
=4 Device Manager P . - e
@ g these functions will be unavsilable. If £y ERHS Supports fil.. Stated  Automatic Local Syste...
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:af‘i WMI Control i Software Protection  Enables the ... Automatic (D... MetworkS...
< | LI} r \B<tended /(Standard

If the problem persists, switch to the standard Perspective authentication to check if the
connection is working.

1. To diagnose if the problem is in the Windows authentication, test with Perspective
authentication. On the Perspective Server, edit the Perspective_Default.config file as
follows:

e Change the authentication type to <Perspective>.

e Change <Integrated Security=SSPI> to the SQL user and password.
2. Restart IS, and then attempt to logon again.
@ Troubleshoot application download issues

1. If the client machine’s operating system is Windows XP, clear the contents of the following
folder: C:\Documents and Settings\<username>\Local Settings\Apps\2.0.

43




Perspective Installation Guide

If the client machine’s operating system is Windows Vista or Windows 7, clear the
contents of the following folder: C:\Users\<username>\AppData\Local\Apps\2.0.

Note: If you delete the contents of the folders, all Click-Once applications will be deleted.
At any time, contact the Technical Support team at 1-877-776-2995 for assistance.

Browse to the Perspective Services URL: http://<IIS server name>/PerspectiveServices.
Click the Launch Perspective button to re-download the entire Perspective application.
In the dialog box that opens, click Run. The Perspective client will automatically launch.

Enter the Perspective Services URL (e.g., http://lISServer/PerspectiveServices), and click
OK.

Proceed to log on.

Integration Services

Integration Services requires MS DTC (Microsoft® Distributed Transaction Coordinator). Ensure
the following options are enabled and refer to the information on Microsoft's website using the
links provided.

1.

Enable Network DTC Access for MS DTC transactions. Follow the instructions in the To
enabled Network DTC Access for MS DTC transactions section on this page:
http://technet.microsoft.com/en-us/library/cc753620(v=ws.10).aspx

Enable XA Transactions. While on the same tab opened in the previous step, select the
Enable XA Transactions check box.

Enable Firewall Exceptions for MS DTC. Follow the instructions on this page:
http://technet.microsoft.com/en-us/library/cc725913(v=ws.10).aspx
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Error Messages

Error Message Explanation
No Connection. Perspective Client error
Solution

. Launch the Perspective client from the Perspective server and attempt to logon.

o Make sure the user account is a member of the [IS_WPG group on the Perspective server.

Response is not well formed .XML. Perspective Client error

Solution

. May be due to a missing bracket or other formatting issue in the
Perspective_Default.config file.

. May also be a permissions issue. See your local Security Policy.

Connection to the service not found/SQL

. L Perspective Server error
Exception/Login failed for user. P

Solution

Ensure the application pool account has access to the database. The account that the
Perspective server is using to connect to the database must be specified as the Application Pool
identity, and requires membership in the IIS_WPG.
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Contact Information

Technical Support

Toll Free: 1-877-776-2995

Phone: (780) 448-0616

Email: support@ppm?2000.com

PPM 2000

Toll Free: 1-888-PPM-9PPM (1-888-776-9776)
Phone: (780) 448-0616

Fax: (780) 448-0618

Email: information@ppm?2000.com
Website: http://www.ppm2000.com
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